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- Transmisiéon en La Plata.
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. Transmision en La Plata.

* %" Canales en emisién.
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Antenas de recepcion.
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~ Conectando el dongle.
%" Soporte del hardware

A

Soporte provisto por:
= kernel: subsistema DVB (Digital Video Broadcast)
= espacio de usuario: dvb-apps
= http://linuxtv.org
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. Conectando el dongle.

%" Soporte del hardware

Soporte provisto por:
= kernel: subsistema DVB (Digital Video Broadcast)
= espacio de usuario: dvb-apps
= http://linuxtv.org
Se requiere el firmware dvb-usb-dib0700.1.120.fw
m Descargarlo de http://linuxtv.org/downloads/firmware
m # cp dvb-usb-dib0700.1.120.fw /lib/firmware
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Conectando el dongle.

El sistema USB

Identificacién (vendor/product ID)

$ /sbin/lsusb
Bus 001 Device
Bus 001 Device
Bus 002 Device
Bus 003 Device
Bus 004 Device

001:
005:
001:
001:
001:

ID 1d6b:0002 Linux Foundation 2.0
ID 1554:5010 Prolink Microsystems
ID 1d6b:0002 Linux Foundation 2.0
ID 1d6b:0001 Linux Foundation 1.1
ID 1d6b:0001 Linux Foundation 1.1
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. Conectando el dongle.

>

* %" El sistema USB

Identificacién (vendor/product ID)

$ /sbin/lsusb

Bus 001 Device 001:
Bus 001 Device 005:
Bus 002 Device 001:
Bus 003 Device 001:
Bus 004 Device 001:
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ID 1d6b:0002 Linux Foundation 2.0 root hub
ID 1554:5010 Prolink Microsystems Corp.

ID 1d6b:0002 Linux Foundation 2.0 root hub
ID 1d6b:0001 Linux Foundation 1.1 root hub
ID 1d6b:0001 Linux Foundation 1.1 root hub
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Conectando el dongle.

El kernel

Mensajes del kernel

$ dmesg | tail

usb 1-1: new high speed USB device using ehci_hcd and address 5
usb 1-1: New USB device found, idVendor=1554, idProduct=5010

usb 1-1: New USB device strings: Mfr=1, Product=2, SerialNumber=3
usb 1-1: Product: STK807X

usb 1-1: Manufacturer: DiBcom

usb 1-1: SerialNumber: 016
dvb-usb: found a ’Prolink Pixelview SBTVD’ in cold state, will try to load a firmware

usb 1-1: firmware: requesting dvb-usb-dib0700-1.20.fw
dvb-usb: downloading firmware from file ’dvb-usb-dib0700-1.20.fw’

dib0700: firmware started successfully.

dvb-usb: found a ’Prolink Pixelview SBTVD’ in warm state.
dvb-usb: will pass the complete MPEG2 transport stream to the software demuxer.

DVB: registering new adapter (Prolink Pixelview SBTVD)

DVB: registering adapter O frontend O (DiBcom 8000 ISDB-T)...

DiB0070: successfully identified

input: IR-receiver inside an USB DVB receiver
dvb-usb: schedule remote query interval to 50

dvb-usb: Prolink Pixelview SBTVD successfully




Mensajes del kernel

$ dmesg | tail

usb 1-1: new high speed USB device using ehci_hcd and address 5
usb 1-1: New USB device found, idVendor=1554, idProduct=5010

usb 1-1: New USB device strings: Mfr=1, Product=2, SerialNumber=3
usb 1-1: Product: STK807X

usb 1-1: Manufacturer: DiBcom

usb 1-1: SerialNumber: 016

dvb-usb: found a ’Prolink Pixelview SBTVD’ in cold state, will try to load a firmware
usb 1-1: firmware: requesting dvb-usb-dib0700-1.20.fw
dvb-usb: downloading firmware from file ’dvb-usb-dib0700-1.20.fw’

dib0700: firmware started successfully.

dvb-usb: found a ’Prolink Pixelview SBTVD’ in warm state.
dvb-usb: will pass the complete MPEG2 transport stream to the software demuxer.

DVB: registering new adapter (Prolink Pixelview SBTVD)
DVB: registering adapter O frontend O (DiBcom 8000 ISDB-T)...

DiB0070: successfully identified

input: IR-receiver inside an USB DVB receiver as /devices/pci0000:00/0000:00:02.1/usbl/1-1/input/input9
dvb-usb: schedule remote query interval to 50 msecs.

dvb-usb: Prolink Pixelview SBTVD successfully initialized and connected.



Conectando el dongle.

Modulos

Driver: dibcom0700

$ lsmod
Module

dvb_usb_dib0700
dib7000p
dib0090
dib7000m
dib0070

dvb_usb

dib8000
dvb_core
dib3000mc
dibx000_common

Size

74739
16582
12661
14232

7528
14740
26312
91431
11404

2798

Used by

B WNRE NP P PO

dvb_usb_dib0700

dvb_usb_dib0700

dvb_usb_dib0700

dvb_usb_dib0700

dvb_usb_dib0700

dvb_usb_dib0700

dib7000p,dvb_usb,dib80%

dvb_usb_dib0700

dib7000p,dib7000m,dipEROR , dib3000mc
|




. Conectando el dongle.

>

* %" Médulos

Driver: dibcom0700

$ lsmod
Module

dvb_usb_dib0700
dib7000p
dib0090
dib7000m
dib0070

dvb_usb

dib8000
dvb_core
dib3000mc
dibx000_common
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Size

74739
16582
12661
14232

7528
14740
25312
91431
11404

2798

Used by

DR W RN R PR O

dvb_usb_dib0700
dvb_usb_dib0700
dvb_usb_dib0700
dvb_usb_dib0700
dvb_usb_dib0700
dvb_usb_dib0700

dib7000p, dvb_usb,dib800

dvb_usb_dib0700

TDT en GNU/Linux

11/27



Conectando el dongle.

Dispositivo

Archivos de dispositivo

$ 1s -1 /dev/dvb/adapterQ

crw-rw-- 1 root video 212, 4 2010-10-19 12:42 /dev/dvb/adapter0/demux0
crw-rw-- 1 root video 212, 5 2010-10-19 12:42 /dev/dvb/adapter0/dvr0
cru-rw-- 1 root video 212, 3 2010-10-19 12:42 /dev/dvb/adapter0/frontend0
crw-rw-- 1 root video 212, 7 2010-10-19 12:42 /dev/dvb/adapter0/net0

frontend: controla el sintonizador y el demodulador.

demux: controla la descomposicién del TS.

La decodificacién de contenidos es por softwfréion
posibilidad de aceleracion por hardware en la

LP/CONICET



Conectando el dongle.

Dispositivo

Archivos de dispositivo

$ 1s -1 /dev/dvb/adapterQ

crw-rw-- 1 root video 212, 4 2010-10-19 12:42 /dev/dvb/adapter0/demux0
crw-rw-- 1 root video 212, 5 2010-10-19 12:42 /dev/dvb/adapter0/dvr0
crw-ru-- 1 root video 212, 3 2010-10-19 12:42 /dev/dvb/adapter0/frontend0
crw-rw-- 1 root video 212, 7 2010-10-19 12:42 /dev/dvb/adapter0/net0
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Archivos de dispositivo

$ 1s -1 /dev/dvb/adapterQ

cru-rw-- 1 root video 212, 4 2010-10-19 12:42 /dev/dvb/adapter0/demux0
crw-rw-- 1 root video 212, 5 2010-10-19 12:42 /dev/dvb/adapter0/dvr0
crw-rw-- 1 root video 212, 3 2010-10-19 12:42 /dev/dvb/adapterO/frontend0
cru-rw-- 1 root video 212, 7 2010-10-19 12:42 /dev/dvb/adapter0/net0

frontend: controla el sintonizadory el demodulador.
demux: controla la descomposicién del TS.

La decodificacién de contenidos es por software con
posibilidad de aceleracién por hardware en la GPU.



USB Bridge
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.  Escaneando.
%" Tabla de frecuencias

o

Obtener el archivo de frecuencias freq.txt

m Tabla de frecuencias UHF para la norma ISDB-Tb disponible
en http://www.linuxtv.org/wiki/index.php/ISDB-T_
Frequency_Table/.

P. Santamaria, UNLP/CONICET TDT en GNU/Linux


http://www.linuxtv.org/wiki/index.php/ISDB-T_Frequency_Table/
http://www.linuxtv.org/wiki/index.php/ISDB-T_Frequency_Table/
http://www.linuxtv.org/wiki/index.php/ISDB-T_Frequency_Table/
http://www.linuxtv.org/wiki/index.php/ISDB-T_Frequency_Table/

. Escaneando.
%" Tabla de frecuencias

o

Obtener el archivo de frecuencias freq.txt

m Tabla de frecuencias UHF para la norma ISDB-Tb disponible
en http://www.linuxtv.org/wiki/index.php/ISDB-T_
Frequency_Table/.

$ cat freq.txt
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Obtener el archivo de frecuencias freq.txt
Tabla de frecuencias UHF para la norma ISDB-Tb disponible

en http://www.linuxtv.org/wiki/index.php/ISDB-T_
Frequency_Table/.

$ cat freq.txt

T 521142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 22
T 527142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 23
T 533142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 24
T 539142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 25
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Obtener el archivo de frecuencias freq.txt
Tabla de frecuencias UHF para la norma ISDB-Tb disponible

en http://www.linuxtv.org/wiki/index.php/ISDB-T_
Frequency_Table/.

$ cat freq.txt

T 521142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 22
T 527142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 23
T 533142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 24
T 539142857 6MHz AUTO AUTO AUTO AUTO AUTO NONE # channel 25

Canales UHF 14 (473Mhz) a 69 (803Mhz) (37 no usado)
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Escaneando.

Buscando canales

Generar el archivo channels.conf

$ scan freq.txt > channels.conf

>>> tune to: 527142857 :INVERSION_AUTO:BANDWIDTH_6_MHZ:FEC_AUTO:...
Network Name ’RTA C23°

0x0000 0xe758: pmt_pid Ox1fc8 (null) - TV Publica (777)

0x0000 Oxe741: pmt_pid 0x0102 (null) - TV Publica HD (777)

0x0000 Oxe742: pmt_pid 0x0103 (null) - Encuentro (?777)

$ cat channels.conf
Encuentro:527142857: INVERSION_AUTO:BANDWIDTH_6_MHZ:FEC

FEC_AUTO:QAM_AUTO: TRANSMISSION_MODE_AUTO:GUARD_INTERV
HIERARCHY_NONE:305:306:59202



Escaneando.

Buscando canales

Generar el archivo channels.conf

$ scan freq.txt > channels.conf

>>> tune to: 527142857:INVERSION_AUTO:BANDWIDTH_6_MHZ:FEC_AUTO:...
Network Name ’RTA C23’°

0x0000 0xe758: pmt_pid Ox1fc8 (null) - TV Publica (?777)

0x0000 Oxe741: pmt_pid 0x0102 (null) - TV Publica HD (777)

0x0000 0xe742: pmt_pid 0x0103 (null) - Encuentro (777)
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_ Escaneando.
G Buscando canales

Generar el archivo channels.conf

$ scan freq.txt > channels.conf

>>> tune to: 527142857:INVERSION_AUTO:BANDWIDTH_6_MHZ:FEC_AUTO:...
Network Name ’RTA C23’°

0x0000 0xe758: pmt_pid Ox1fc8 (null) - TV Publica (?777)

0x0000 Oxe741: pmt_pid 0x0102 (null) - TV Publica HD (777)

0x0000 0xe742: pmt_pid 0x0103 (null) - Encuentro (777)

$ cat channels.conf
Encuentro:527142857: INVERSION_AUTO:BANDWIDTH_6_MHZ:FEC :UTU:\

FEC_AUTO:QAM_AUTO: TRANSMISSION_MODE_AUTO:GUARD_INTERVAL_AUTO:\
HIERARCHY_NONE:305:306:59202
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- Testeando la calidad de la recepcion

Utilizando femon

Sintonizar una frecuencia y programa con tzap.

$ tzap -c channels.conf "Encuentro"

$ femon -H
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Sintonizar una frecuencia y programa con tzap.

$ tzap -c channels.conf "Encuentro"

using ’/dev/dvb/adapter0/frontend0’ and ’/dev/dvb/adapter0/demux0’

reading channels from file ’channels.conf’

tuning to 527142857 Hz

video pid 0x0131, audio pid 0x0132

status 03 | signal 9e22 | snr 00c6 | ber 00000000 | unc 00000000 |

status 1f | signal 9e20 | snr 00cf | ber 00000000 | unc 00000000 | FE_HAS_LOCK
status 1f | signal 9df9 | snr 00db | ber 00000000 | unc 00000000 | FE_HAS_LOCK

Ejecutar simultdneamente el monitor del frontend: femon

$ femon -H

FE: DiBcom 8000 ISDB-T (DVBT)

status SCVYL | signal 61% | snr 0% | ber 0 |func 0| FE_HAS_LOCK
status SCVYL | signal 61% | snr 0% | ber 07| unc O | FE_HAS_LOCK



- Testeando la calidad de la recepcion
Parametros explicados

>

l‘,‘%‘

status SCVYL | signal 61% | snr 0% | ber O | unc O | FE_HAS_LOCK

Estado del dispositivo

S: sefial detectada.

C: sefial digital detectada.
V: deteccién y correccién de errores estable.
Y: bits de sincronizacién encontrados.

L: senal adquirida.
FE_HAS_LOCK: sefial adquirida, todo OK’!W
:jk:_-;
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Testeando la calidad de la recepcion

Parametros explicados

status SCVYL | signal 61% | snr 0% | ber O | unc O | FE_HAS_LOCK

Potencia de la sefal

= Signal: potencia de la sefial.

= SNR: relacién sefial a ruido.

TDT en GNU/Linux



Testeando la calidad de la recepcion

Parametros explicados

status SCVYL | signal 61% | snr 0% | ber O | unc O | FE_HAS_LOCK

Potencia de la sefal

= Signal: potencia de la sefial.

= SNR: relacién sefial a ruido.
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~ Testeando la calidad de la recepcion
"% Parametros explicados

>

status SCVYL | signal 61% | snr 0% | ber O | unc O | FE_HAS_LOCK

Calidad de la senal digital

» BER: tasa de bits con error.

= UNC: bloques incorregibles.
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e

Testeando la calidad de la recepcion

Parametros explicados

U‘,‘og

status SCVYL | signal 61% | snr 0% | ber O | unc O | FE_HAS_LOCK

Calidad de la senal digital

» BER: tasa de bits con error.

= UNC: bloques incorregibles.

Nota: Si sus valores son fluctuantes y altos no se vera nada ain si
la potencia es alta.

P. Santamaria, UNLP/CONICET
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.5 - Television digital con VLC

VLC media player
= Reproductor multimedia GLP.
= Apto para dispositivos ISDB-Tb.

m Codecs de los proyectos ffmpeg,
x264, faad2/faac.

= http://www.videolan.org/vic/

TDT en GNU/Linux
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Encuentro - VLC media player

Media_Playback Audio_Video Tools View Help

Playlist
Playlist

Title
=i Encuentro
Paka Paka
& Canal 22 5erv.3
& Canal 22 Serv.4
& Encuentro Movil
TV Publica HD
v publica
®f Encuentro
GolTv
Canal 24 5erv.2
Canal 24 5erv.3

& CN23 Movil

« »
B0 [vee] @ [om] [m[:=10t] [€®]26
Encuentro 1.00x [ 00:00/00:00

La lista de canales aparece como una-lista de reproduccién.



Navegando por la lista

Paka Paka - VLC media player

To0¢ [ana0nusn

Atajos de teclado:
f: Pantalla completa

Ctrl+l:
Ocultar/mostrar lista

n: Siguiente en la lista

p: [Previo en la lista



Desentrelazando la imagen:
$ vlc --vout-filter=deinterlace --filter—deinterlace-mode blend \

channels.conf &

x Atajo de teclado:

I ref

é Video Settings

d: Activa/desactiva

s desentrelazado.

Iy | Default = .

> : = Modos:

S blend, mean, bob, linear, X,
summ‘n s05 W L B:whg ya d i f .

3

=8

s | e e

Tools > Preferences



Cambio de la razén de aspecto X:Y

Atajo de teclado:
a: Cambia la razén de
aspecto a 1:1, 4:3,
16:9, 16:10, ...

- “OTRAS VOCES"

CN23®  secumos en [l www.youtube com/cn23ty  21:37 2271 ‘

| il ]

p |

: mame ||| 2l ‘ |

| B ! .\,‘\,y \‘1‘ {

| ] | = . 11 '
| }1/\L | | o IL s

frad = ‘ ‘ e

(¢ | | l‘ [



Cambio de la razén de aspecto X:Y

Atajo de teclado:
a: Cambia la razén de
aspecto a 1:1, 4:3,
16:9, 16:10, ...




Capturas y grabacién: View > Advanced Controls

B crcvero Vi nadaphrec Atajos de teclado:

Media_Playback Audio Video Tools View Help

Shift+r: Grabacién

Shift+s: Captura de
pantalla

Grabacién
m -

IR CICN-TEIREIES @

{
Ercuenro [ii06x [G000/00:00




Decodificaciéon H264 en la GPU (Unidad de Procesamiento

Gréfico)

$ vlc --fmpeg-hw channels.conf &

[ Input & Codecs Settings
e Default opical device Idevidud Browse.
g 6 [3]
ot
) e
& =
o Damaged or incomplete AV file. Askfor action
4 Record directc
R =
-
R Nework
LSO Default port (sesver mode) 12345
4 HTTP proxy URL
R o e ity 1 v 75 1)
piea cotos =
4
=
e o ) ot

Tools > Preferences

Requiere:

drivers: intel, nvidia/ati
(propietarios).

VAAPI (Video Acceleration
API): 1ibdva + back-ends.
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